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Creating a Die Package  

In this lesson, you'll use the Die Wizard to parametrically construct a die part 
definition. You will also learn how to import die pad data from a text file and 
modify the imported data. 

In this lesson: 

 Entering parametric die data 
 Importing die data from an ASCII text file 
 Modifying imported die data 
 Adding the die to the design 
 Understanding the ASCII text file format 

Restriction 

 This tutorial requires the General Editing licensing option. On the Help 
menu, click Installed Options to determine whether you can proceed. 

Preparation 

If it is not already running, start PADS Layout and open the file named 
previewrules.pcb in the \PADS Projects\Samples folder. 
Use a Start-up file to set preferences required for this tutorial. 

Open a start up file 
 

File menu > New 

To use the Start-up file: 

1. In the Set Start-up File dialog box, select PBGAtutorial.stp. 
Tip: If the Set Start-up File dialog box doesn't appear, on the File menu, click 
Set Start-up File. 

2. Click OK.  

Creating a Die Package 1 



Entering parametric die data 
 

BGA button  > Die Wizard button  

You can use parametric construction to construct a die part definition in the 
absence of electronic data like GDSII or ASCII. Parametric construction is ideal 
for scenarios requiring package feasibility studies before the die is complete. 
The Die Wizard provides a preview window that dynamically updates as you 
enter parameters. 

Defining the die outline 

To define the outline size: 

1. In the Create Die dialog box, click the Parametrically button. 
2. In the Die Wizard - Create Parametrically dialog box click the Die Size tab. 
3. In the Units area select Metric. 
4. In the Die Part Type box, type DIE248 as the name. 
5. In the Length box, type 8 to specify a die length of 8 mm. 
6. In the Width box, type 8 to specify a die width of 8 mm. 

Defining the chip bond pads 
Die Wizard – Create Parametrically dialog box > CBP tab 

To define the pads: 

1. In the Total box, type 248 to specify a total pad count of 248. 
2. Make sure that GND % and PWR % are set to 10. This specifies 10% of the 

pads on a per-side basis to be GND and PWR. 
3. In the Pad Pitch box, type .12 to specify a pad pitch of .12 mm. 
4. In the Distance from Die Edge box, type .1. 
5. In the Pad Shape area, on the Shape list, select Rectangle. 
6. In the Length box, type .07 to specify a pad length of .07 mm. 
7. In the Width box, type .07 to specify a pad width of .07 mm. 
Tip: Select any of the cells in the spreadsheet to override total pad, GND, or 
PWR pad count values. 
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Defining the pad numbering 
Die Wizard – Create Parametrically dialog box > Pad # tab 

To define the pad numbering: 

 In the Pad 1 Side area, select Top to move pin 1 to the left side of the top row 
of pads. 

Defining pad function names 
Die Wizard – Create Parametrically dialog box > Pad Functions tab 

To define the pad function names: 

 Although no changes are required in this area, browse through the pad list to 
review the pad function names. 

Tip: Select any of the pad function name cells to override pad function names. 

Defining die wizard preferences 
Die Wizard – Create Parametrically dialog box > Die Prefs tab 

To define the die wizard preferences: 

1. In the Part Creation Mode area, click Add Part to Design. This automatically 
adds the die part to the design. 

2. You have defined the die part. For the purpose of this exercise, click Cancel 
since you are importing an ASCII file in the next section. If you were to 
click OK, the part definition would be created automatically and added to 
the design. 

Importing die data from an ASCII text file 
 

Die Wizard button  

To import the data: 

1. In the Create Die dialog box, click the From Text File button, to import die 
data from an ASCII text file. 

2. In the Die Wizard - Create from Text File dialog box, click Browse. 
3. Navigate to the \PADS Projects\Samples folder and click Die248.csv. 
4. Click Open to import the contents of the file into the Die Wizard. 

Result: The Preview window displays the imported die data. 
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Modifying imported die data 
 

Die Wizard – Create from Text File dialog box > Die Size tab 

Once you import the die data into the Die Wizard, you can modify or override 
most aspects of the data: die outline, origin, pad numbering, pad size, pad shape, 
and pad function names.  
The default die outline is a bounding box surrounding the die pads. It often 
needs to be modified. 

To change the die outline: 

1. Make sure Metric is selected in the Units area. 
2. In the Length box, type 8 to specify a die length of 8 mm. 
3. In the Width box, type 8 to specify a die width of 8 mm. 

Adding the die to the design 
 

Die Wizard – Create from Text File dialog box > Die Prefs tab 

To add the die part to the design: 

1. In the Part Creation Mode area, click Add Part to Design. This adds the part 
die to the design automatically when you close the dialog box. 

2. Click OK. 
3. On the standard toolbar, click the Board button to resize the window view. 

 

Understanding the ASCII text file format 
 

In the previous exercise you imported an ASCII text file into the Die Wizard to 
initiate the Die Part definition. This data may come from the IC place and route 
design system, a spreadsheet program like Microsoft® Excel, or a text editor. 

File format 

The first line of the file must specify the units. Acceptable values are, Mil, MM, 
Micron, and Inch. These values are not case sensitive. 
The pad data must be in the following format to import correctly into the Die 
Wizard. A comma must separate each field. 
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Pad data format: 

Pad# Pad Function Xcoord Ycoord Pad Length Pad Width 

1 GND -3.66 3.865 0.07 0.07 

2 PWR -3.54 3.865 0.07 0.07 

3 SIG003 -3.42 3.865 0.07 0.07 

Pad data explanation: 

Data Description 

Pad# The chip bond pad number 

Pad Function The pad function name 
Xcoord The X distance from the origin of the die 

Ycoord The Y distance from the origin of the die 

Pad Length (Optional) The length of the die bond pad. When no value is 
specified one is derived automatically. 

Pad Width (Optional) The width of the die bond pad. When no value is 
specified, one is derived automatically. If the Pad Length is 
specified but the Pad Width is not specified, the pad is 
assumed to be circular. 

Sample Text File: 
MM,,,,, 
1,GND,-3.66, 3.865, 0.07, 0.07 
2,PWR,-3.54, 3.865, 0.07, 0.07 
3,SIG003,-3.42, 3.865, 0.07, 0.07 
4,SIG004,-3.3, 3.865, 0.07, 0.07 
5,SIG005,-3.18, 3.865, 0.07, 0.07 
 
 Do not save a copy of the design. 

You completed the creating a die package tutorial. 
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Creating Ball Grid Array Patterns  

In this lesson, you'll learn how to create a ball grid array (BGA) and add it to 
the design.  
Component footprints are called PCB decals in PADS Layout. To create a BGA 
you must use the Decal Editor to create the pattern as a PCB decal, create a part 
type, and assign the BGA decal to the part type. 

In this lesson: 

 Creating a BGA decal 
 Saving the decal 
 Adding the BGA component to the design 

Restriction 

 This tutorial requires the ECO, Library Editor and General Editing licensing 
options. On the Help menu, click Installed Options to determine whether you 
can proceed. 

Requirement: You must understand the concept of PADS Layout library parts 
before proceeding with this tutorial. See the section called Understanding the 
PADS Layout part type and PCB decal in the Creating library parts tutorial. 

Preparation 

If it is not already running, start PADS Layout and open the file named 
PBGAtutorial_1.pcb in the \PADS Projects\Samples folder. 
 

Creating a BGA decal 
 

The Decal Editor provides a BGA Pin Wizard. In this wizard you enter specific 
parameters for the BGA and the wizard automatically creates the BGA footprint. 
In this tutorial, you will create a BGA package with 23 rows and 23 columns 
with a 1.27mm pitch and .75mm ball pad. 
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Using the BGA pin wizard 

Tools menu > Decal Editor > Drafting button  > Wizard button  

Use the Pin Wizards dialog box to create complex pad array patterns after you 
specify the pattern. 

To create the BGA footprint: 

1. In the Pin Wizards dialog box click the BGA/PGA tab. 
2. In the Units area, select Metric. 
3. In the Origin area, select Center. 
4. In the Decal Type area, select Substrate. The message Substrate Decal Type 

selected, terminal numbering will be mirrored appears. Click OK. 
5. In the Silk Screen area, clear Create. 
6. In the Pad Stack area, click SMD. 
7. In the Diameter box, type .75. 
8. Select Assign JEDEC Pinning. 
9. In the Row Pitch and Column Pitch boxes, type 1.27. 
10. In the Row Count and Column Count boxes, type 23. 
11. In the Void Rows and Void Columns boxes, type 15. 
12. In the Center Rows and Center Columns boxes, type 5. 
13. Click OK. The completed PCB decal appears in the workspace. 

Substrate or component decal type 

When creating a BGA pattern for a component (a BGA to mount on the PCB 
design), you create a BGA with pin A1 in the upper left corner of the pattern. 
However, when creating BGA patterns to add to the design of a BGA substrate, 
you orient the decal with pin A1 in the upper right corner of the pattern because 
the BGA pattern is mirrored and placed on the bottom layer of the design. The 
final position of the BGA pattern has pin A1 in the upper left. 
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Saving the decal 
 

File > Save Decal 

Before you can add the BGA to your design, save the decal and create a part 
type. In PADS Layout these two steps are combined into a single operation. 

To save the decal to the library: 

1. On the Save Alphanumeric to Library dialog box, in the Library list, select  
\Program Files\Mentor Graphics\PADS\<latest_release>\Libraries\usr. 

2. In the Name of PCB Decal box, type BGA329. 
3. Select Save Alphanumerics to enable other parts of the dialog box. 
4. Select Create New Part Type. 
5. In the Part Type area, in the Library list, select 

 \Program Files\Mentor Graphics\PADS\<latest_release>\Libraries\usr. 
6. In the Name of Part Type box, type BGA329. 
7. Click OK to close the dialog box and save the decal and part type. If a prompt 

appears asking to confirm overwriting an existing part decal or part type, 
click Yes. 

8. On the File menu, click Exit Decal Editor to leave the Decal Editor and 
return to the Layout Editor. 

Adding the BGA component to the design 
 

BGA button  > Add Component button  

You can now add the BGA component to the design and place it on the 
bottom layer.  

To add the BGA from the Layout Editor: 

1. In the Get Part Type from Library dialog box, in the Items box, type bga* and 
click Apply.  
Result: The preview:BGA329 part appears in the Part Types list. 

2. Select usr:BGA329 and click Add to add an instance of the part type to 
the design.  
Result: A dialog box appears prompting you to enter a prefix for the part to 
add. This is the prefix of the part's reference designation (for example, R for 
resistors or C for capacitors). 

3. Type BGA in the box and click OK.  
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Result: An instance of the BGA329 part type, named BGA1, is attached to the 
pointer. 

4. Click Close on the Get Part Type from Library dialog box. 
5. To place the BGA pads on the bottom side of a BGA substrate, right-click and 

click Flip Side. This mirrors the part and places it on the bottom layer of 
the design. 

6. Position your pointer over the design origin marker at the center of the die 
component and click the left mouse button to place the BGA component at 
the design origin. 
Tip: You can also use the Search modeless command to assist in placing the 
part. Type s 0 0, press Enter, and then press Spacebar. 

7. On the standard toolbar, click the Board button to resize the window view. 
 

8. Do not save a copy of the design. 

You completed the creating ball grid array patterns tutorial. 
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Creating a Substrate for the Package  

The next step in designing advanced packages with PADS Layout is to create a 
substrate outline, also known as a board outline. 

In this lesson: 

 Creating a board outline 

Restriction 

 This tutorial requires the Drafting Editing and Physical Design Reuse 
licensing options. On the Help menu, click Installed Options to determine 
whether you can proceed. 

Preparation 

If it is not already running, start PADS Layout and open the file named 
PBGAtutorial_2.pcb in the \PADS Projects\Samples folder. 

Creating a board outline 
A board outline is created using the same polygon creation methods used to 
create drafting items. 

1. Drafting button  > Board Outline and Cut Out button . 
2. Type g1 and then press Enter to set all grids to 1 mm.  

Result: The message All grids set to 1 1 appears in the status bar. 
3. Type gd1 and then press Enter to set the Display Grid to 1.  

Result: The message Dot grid set to 1 1 appears in the status bar.  
Tip: You may have to zoom in to see the grid. 

4. Right-click and click Rectangle. 
5. Move the pointer to location -15,-15 and click the left mouse button. You can 

locate -15,-15 using the Search modeless command. Type s -15 -15 and press 
Enter. A dynamic rectangle attaches to the pointer. 

6. Move the pointer to 15, 15 and click the left mouse button to complete the 
board outline. You can use the Search modeless command here as well. 

7. On the standard toolbar, click the Board button to center the board in view. 
 

8. Do not save a copy of the design. 

You completed the creating a substrate for the package tutorial. 
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Defining Layers and Design Rules 

Design rules include clearance, routing, and high-speed constraints assigned as 
default conditions or assigned for nets, layers, class groups, or pin pairs. You can 
also assign conditional design rules and differential pairs.  

In this lesson: 

 Setting the layer arrangement for the BGA substrate 
 Setting layer stackup 
 Modifying the default via 
 Setting default clearance rules 
 Using on-line design rule checking (DRC) 
 Setting display colors 

Restriction 

 This tutorial requires the ECO, General Editing and Physical Design Reuse 
licensing options. On the Help menu, click Installed Options to determine 
whether you can proceed. 

Preparation 

If it is not already running, start PADS Layout and open the file named 
PBGAtutorial_3.pcb in the \PADS Projects\Samples folder. 

Setting the layer arrangement for the BGA substrate 
 

Setup menu > Layer Definition 

With PADS Layout you can define the layer arrangements for the BGA design. 
This includes assigning the number of layers, nets associated with embedded 
plane layers, layer stackup, and layer thickness.  
The tutorial design will be fabricated as a two-layer substrate.  

To set the first layer: 

1. In the Layers Setup dialog box, select Top in the list of layers.  
2. In the Name box type Die Side. 
3. In the Electrical Layer Type area, click Component. 
4. In the Plane Type area, click No Plane. 
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5. Set the Routing Direction to Vertical. 

omponent. 

he Layers Setup dialog box. 

Setting lay

To set the second layer: 

1. Select Bottom in the list of layers. 
2.  In the Name box type BGA Side. 
3. In the Electrical Layer Type area, click C
4. In the Plane Type area, click No Plane.  
5. Set the Routing Direction to Horizontal. 
Tip: Do not close t

er stackup 
 

Laye

 a two-layer FR4 substrate is composed of a fiberglass 

 the line for the Die Side layer, double-

Thickness cell. The cell 

5.  the Thickness cell. Type 2 
ck the Dielectric cell, and 

he Layers Setup dialog box. 

Modifying the default via 

rs Setup dialog box > Thickness button 

A typical layer stackup for
substrate copper clad on both sides. Use the Layer Thickness dialog box to set 
the layer stackup values. 
1. In the Layer Thickness dialog box on

click the Thickness cell. The cell switches to in-place editing mode. 
2. In the Thickness cell type .01 (mm). 
3. On the line for the BGA Side layer, double-click the 

switches to in-place editing mode. 
4. In the Thickness cell type .01 (mm). 

On the line for the Substrate type double-click
(mm) to set thickness. On the same line, double-cli
then type 4.5 to set dielectric constant value. 

6. Click OK to close the Layer Thickness dialog box. 
7. Click OK to close t

 

Setup

iting, you need to modify the default via definition.  

ad Stack Type area,  

layer) list, select CNN 0.254 <Start>. 

 menu > Pad Stacks 

As preparation for route ed

To modify the default via: 

1. In the Pad Stacks Properties dialog box, in the P
click Via. 

st. 2. Select STANDARDVIA in the Decal Name li
3. In the Sh.: Sz.: Layer: (shape, size, 
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4. In the Diameter box type .4. 
5. In the Sh.: Sz.: Layer: list select CNN0.254 <Inner Layers>. 

ct CNN 0.254 <End>. 

10. ties dialog 
b sure you want to change all vias of type 

11. Click Yes to change all vias of type STANDARDVIA. 

Setting default clearance rules 

6. In the Diameter box, type .4. 
7. In the Sh.: Sz.: Layer: list sele
8. In the Diameter box, type .4. 
9. In the Drill Size box, type .16. 

 Click OK to save the via definition and close the Pad Stacks Proper
ox. The message Are you 

STANDARDVIA appears. 

 

Setup me
Clear

nce 
 The 

s. 

1. efault clearance value by clicking All in the upper left corner of 

2. nd then click OK.  
e simultaneously. 

e: 

box 

et area, type .07 in the following boxes:  

er 

ll and Body to Body boxes. 

nu > Design Rules > Rules dialog box > Default button > Default rules dialog box > 
ance button 

With PADS Layout, you can define constraints for clearance and routing, and 
high-speed constraints for each layer of the design rule hierarchy. The Cleara
area of the Clearance Rules dialog box contains a matrix of design data.
matrix data lets you specify clearance values for each or all data type

To assign clearance rules: 

Set a global d
the matrix.  
In the Input Clearance Value dialog box type .07 a
Result: All matrix values chang

3. In the Trace Width area, typ
 .07 in the Minimum box 
 .07 in the Recommended 
 .5 in the Maximum box. 

4. In the Same N
 Via to Via 
 SMD to Corn
 SMD to Via 
 Pad to Corner. 

5. In the Other area, type .07 in the Drill to Dri
6. Click OK in the Clearance Rules dialog box. 
7. Click Close in the Default Rules dialog box. 
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8. To save the changes, click Close in the Rules dialog box. 

Using on-line design rule checking (DRC) 
 

You can enable real-time design rule checking during placement and routing 
operations to ensure that design constraints are maintained throughout the 

is called DRC. You set DRC modes in 
 dr modeless commands. 

 four mo

DRC Mode 

design process. This interactive checking 
the Preferences dialog box or by using the

There are des of DRC operation: 

Description 

DRC Off Turns off design rule checking.  
Modeless command: dro. 

DRC Ign Clr Ignores all clearance rules but prevents the intersection of 
traces during routing. 
Modeless command: dri. 

DRC Warn Generates error messages for violations
Modeless command: drw. 

. 

DRC Prevent  Prevents you from creating violations. 
odeless command: drp. M

Setting display colors 
 

Setu

or invisible 
ialog box. You can also set the color for the screen 
d other elements. 

Assign

1. 
2.  by Layer area, select each color box for the items under the 

Design Items area in the row associated with BGA Side to assign the light 

Assign

1. 
r area, select the Errors color box under Design Items for 

 Side layers to assign the yellow color for errors. 

p Menu > Display Colors 

You assign or change layer colors and make individual items visible 
in the Display Colors Setup d
background, board outline, an

ing a new color to the BGA 

Click light blue in the Selected Color area. 
In the Color

blue color. 

ing colors to other items 

Click yellow in the Selected Color area. 
2. In the Color by Laye

the Die Side and BGA
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Saving the color arrangement 

 When you finish 
Colors Setup dialog box, save the color 

. 
4. If the new configuration name does not appear in the Configuration area, 

5. Click OK to apply the colors and to close the Display Colors Setup dialog box. 
6. Do not save a copy of the design. 

You completed the defining layers and design rules tutorial. 

You can save color arrangements to reuse from design to design.
assigning colors to items in the Display 
arrangement. 
1. Click Save. 
2. In the Save configuration dialog box, type All Items Visible. 
3. Click OK to save the configuration

select it from the list.   
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Creating a Wire Bond Fanout 

In this lesson, you'll create the wire bond fanout pattern. 

In this lesson: 

 Creating a wire bond fanout 
 Exploring additional wire bond options 

Restriction 

 There are no restrictions for this tutorial. 

Preparation 

If it is not already running, start PADS Layout and open the file named 
PBGAtutorial_4.pcb in the \PADS Projects\Samples folder. 

Creating a wire bond fanout 
 

BGA button  

To start the Wire Bond Wizard: 

1. Right-click and click Select Components. 
2. Select die part U1. Use the Tab key if necessary to cycle through the 

selections. 
3. On the BGA toolbar, click the Wire Bond Wizard button to open the Wire 

Bond Wizard for U1.  

Defining the ring geometry 
Wire Bond Wizard dialog box > Guide tab 

To define the ring sizes: 

1. In the SBP Rings area of the Wire Bond Wizard, select Ground. 
2. In the Size area, type .5 in the X and Y boxes, and then click Distance 

from Die. 
3. In the SBP Rings area, select Power. 
4. In the Size area, type 1.25 in the X and Y boxes, and then click Distance from 

Die. 
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5. In the SBP Rings area, select Signal. 
6. In the Size area, type 2 in the X and Y boxes, and then click Distance 

from Die. 
7. In the Shape area, select Arced in the list, and then type .8 into the 

Height box. 

Setting fanout preferences 
Wire Bond Wizard dialog box > Fanout Prefs tab 

To set ring fanout preferences: 

1. In the SBP Rings area, Ctrl+click both the Ground and Power rings. 
2. In the Substrate Bond Pad area, in the Shape list, select Rectangle. 
3. In the Length and Width boxes, type .04. 
4. In the Focus area, select CBP to specify substrate bond pad alignment to the 

component bond pads. 
5. In the Wire Bond area, type .025 in the Width box, and then type 0 in the 

Offset box. 
6. In the SBP Ring area select the Signal ring. 
7. In the Substrate Bond Pad area, in the Shape list, select Oval. 
8. In the Length box type .3. 
9. In the Width box type .1. 
10. In the Focus area, select CBP to specify substrate bond pad alignment to the 

component bond pads. 
11. In the Wire Bond area, type .025 in the Width box, and then type 0 in the 

Offset box. 

Assigning wire bond rules 
Wire Bond Wizard dialog box > Rules area > Wire Bond Rules button 

To assign fanout rules: 

1. Select all the rule check boxes to enable all checks. 
2. In the WB to WB Clearance box type .03. 
3. In the WB to SBP Clearance box type .03. 
4. In the Min Length box type .5. 
5. In the Max Length box type 2.9. 
6. In the Max Angle box, type 45. 
7. Click OK to accept the rules and close the Wire Bond Rules dialog box. 
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Assigning chip bond pads to rings 
Wire Bond Wizard dialog box > Assign CBPs button 

To assign pads to rings: 

1. On the Assign CBPs to Rings dialog box, in the View by list, select CBP 
Function. 

2. In the CBP Function column, select GND. 
3. In the Assign to area select the Ground check box. 
4. Click Apply.  

Result: All the CBPs with the GND function name will be assigned to the 
Ground ring. 

5. In the CBP Function column, select PWR. 
6. In the Assign to area, select the Power check box. 
7. Click Apply.  

Result: All the CBPs with the PWR function name will be assigned to the 
Power ring. 

8. Click the Select All button to select the remaining CBP function names. 
9. In the Assign to area select the Signal check box. 
10. Click Apply.  

Result: The remaining CBPs will be assigned to the Signal ring. 
11. Click Close to close the dialog box. 

Specifying the wire bond fanout strategy 
Wire Bond Wizard dialog box > Strategy tab 

The Strategy tab contains options you can specify to improve routing and 
manufacturability. 

To specify the strategy: 

1. In the SBP Rings area, Ctrl+click the Ground and Power rings. 
2. In the Preferred Spacing area, select the WB to SBP check box. 
3. In the WB to SBP box, type .07 to specify the preferred wire bond to substrate 

bond pad spacing. 
4. Select the Force Preferred Spacing check box. 
5. In the SBPs Having Same Function Name area, select Create Nets from Pin 

Function. 
6. In the SBP Rings area, select the Signal ring. 
7. In the Preferred Spacing area, select the SBP to SBP check box. 
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8. In the SBP to SBP box, type .1 to specify the preferred substrate bond pad to 
substrate bond pad spacing. 

9. Select the Force Preferred Spacing check box. 
10. In the SBPs Having Same Function Name area, select the Create Nets from 

Pin Function check box. 

Previewing and checking the wire bond fanout 

To preview the fanout: 

1. In the Preview Options area of the Wire Bond Wizard dialog box, select the 
Report check box. 

2. Click the Preview Fanout button. The wire bond fanout is displayed in the 
workspace and the Wire Bond Wizard Report is generated. 

3. Browse the report. Notice there are Max Length violations on the Signal ring. 
These violations were introduced on purpose to illustrate rule checking and 
reporting. 

4. Close the report. 
5. Click the Wire Bond Rules button. Change the Max Length to 3, then close 

the Wire Bond Rules dialog box. Refer to the "Specifying Wire Bond Rules" 
section, for more information. 

6. Click the Preview Fanout button again. Browse the Wire Bond Wizard Report 
and notice the Max Length violations have been resolved. 

7. Close the report. 

Generating the wire bond fanout 
Wire Bond Wizard dialog box > Create Fanout button 

After you click the Create Fanout button, a dialog box appears indicating that 
GND and PWR nets are being created. 

To complete the fanout: 

1. Click Close to close the dialog box.  
Result: The Wire Bond Wizard Report appears. 

2. Browse the report. Close it when you are done. 
3. Click OK to close the Wire Bond Wizard. 

Exploring additional wire bond options 
 

Wire Bond Wizard button  
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The previous steps covered the basics of creating the wire bond fanout patterns. 
You can use additional controls for fine-tuning or producing alternative results. 

Importing substrate bond pad function names from a netlist 

The Substrate Bond Pad Function Name matches the Chip Bond Pad Function 
Name. In some cases you may want the Substrate Bond Pad Function Name to 
reflect the associated net name. SBP Properties enable the netlist to scan to 
derive the Substrate Bond Pad Function Name from the net names. 

To import pad function names: 

1. Click the die in the workspace. This opens the Wire Bond Wizard for U1. 
2.  In the Wire Bond Wizard dialog box, click the SBP Properties button. 

The Substrate Bond Pad Function Name matches the Chip Bond Pad 
Function Name. 

3. Click the Derive from Netlist button. 
4. Navigate to the \PADS Projects\Samples folder, and then double-click the 

SBPnetlist.asc file to open it. 
5. Select U1 in the Select Component area and then click OK. 

Result: The SBP function names now reflect their associated net name. 
6. Click OK to close the SBP Properties dialog box. 

Saving and loading setup files 
Wire Bond Wizard dialog box > Load Setup button 

When you are satisfied with the wire bond setup, you can save the parameters to 
a file for use on other designs. Clicking Save Setup writes all the parameters to a 
file. Chip Bond Pad assignments are not written because they differ from design 
to design. 

To load a pre-existing wire bond setup file: 

1. Navigate to the \PADS Projects\Samples folder, and then click the 
PBGAtutorial_4.wbw file. 

2. Click Open to read the file. 
3. Do not save a copy of the design. 

You completed the creating a wire bond fanout tutorial. 
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Editing Wire Bond Pads 

Once you create a wire bond fanout pattern in PADS Layout you may want to 
make some adjustments.  

In this lesson: 

 Modifying substrate bond pads 
 Checking wire bond rules 
 Adding wire bonds and substrate bond pads  

Restriction 

 This tutorial requires the General Editing and Verify Design licensing 
options. Click Installed Options on the Help menu to determine whether you 
can proceed. 

Preparation 

If it is not already running, start PADS Layout and open the file named 
PBGAtutorial_5.pcb in the \PADS Projects\Samples folder. 

Modifying substrate bond pads 
 

Changing bond pad shapes 

To change the shape of a substrate bond pad: 

1. Zoom into the upper right portion of the wire bond fanout. 
2. Use the modeless command g .01 to specify a .01 grid. 
3. Right-click and click Select Traces/Pins. 
4. Using the modeless Search command, type s u1.65 and then press Enter. 

This moves the pointer to the U1.65 substrate bond pad. Press Spacebar to 
select it. 

5. With the U1.65 substrate bond pad selected, right-click and click 
Query/Modify SBP.  

6. In the Shape area, in the Shape list, select Rectangle.  
7. In the Shape area, type .5 into the Length box. Click Apply.  

Result: The substrate bond pad has been updated with the new parameters. 
8. Click Cancel to close the dialog box. 
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9. On the standard toolbar, click the Undo button to set the substrate bond pad 
back to its original parameters.  

Tip: You can use the Query/Modify SBP dialog box to modify the parameters for 
an individual or a group of substrate bond pads. 

Moving substrate bond pads 

To move a bond pad: 

1. Select substrate bond pad U1.65. 
2. Right-click and click Move SBP. 
3. Move your pointer and notice how the substrate bond pad is attached 

dynamically. Also notice the rings defined in the Wire Bond Wizard are now 
displayed for reference. 

SBP and rings: 

 
4. Move the pointer so the substrate bond pad is off the signal ring. Now move 

the substrate bond pad back onto the signal ring and notice the automatic 
snapping. 

5. Move and place the substrate bond pad as shown. 
Tip: You can set the parameters for wire bond snapping on the Die Component 
tab of the Preferences dialog box. 
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Checking wire bond rules 
 

Tools menu > Verify Design 

To check the wire bonds: 

1. Select Wire Bonds in the Check area. 
2. Click Start. The message Wire Bond rules checking has been done for the 

current window. Number of errors found- ? (2 or 3, depending upon the 
placement) appears. 

3. Click OK in the message box. 
4. Notice the violations that appear in the Location area and the reason for the 

violations in the Explanation area. Also notice the error markers in the area 
of the design where the recent wire bond edits were performed. Review the 
violations. 

5. Click the Clear Errors button. Click Close to close the dialog box. 
6. On the standard toolbar, click the Undo button to reset the substrate bond 

pad back to its original location.  

Adding wire bonds and substrate bond pads 
 

BGA button  > Wire Bond Editor button  

Some nets may require additional wire bonds and substrate bonds to increase 
current capacity. 

To add a pad: 

1. Select the U1 die component. 
2. Zoom into the upper right portion of the wire bond fanout. 
3. Right-click and click Add SBP.  
4. In the Add Substrate Bond Pad dialog box, type GND in the Function box.  
5. Click Add to accept the parameters and close the dialog box. 
6. A new substrate bond pad attaches to the pointer and the rings appear for 

reference. 
7. Place the new substrate bond pad above the upper-most substrate bond pad 

on the right side of inner ring (GND). The new substrate bond pad remains 
selected. 

8. Right-click and click Add WB. A new wire bond appears on the pointer 
originating from the new substrate bond pad. 
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SBP placement and wire bond connection: 

 
9. Connect the new wire bond to the upper-most chip bond pad on the right side 

of the die. 
10. Right-click and click Cancel. 
11. Click Exit Wire Bond Editor. 

Tip: After making interactive wire bond edits, you should use Verify Design 
to check the edits. 

12. Do not save a copy of the design. 

You completed the editing wire bond pads tutorial. 
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Connecting With a Netlist 

You can establish a netlist and create connections interactively using tools on the 
BGA toolbar. 

In this lesson: 

 Importing a partial netlist 
 Displaying and hiding connections 
 Creating connections interactively  
 Swapping pins 

Restriction 

 This tutorial requires the ECO and Verify Design security options. On the 
Help menu, click Installed Options to determine whether you can proceed. 

Preparation 

If it is not already running, start PADS Layout and open the file named 
PBGAtutorial_5.pcb in the \PADS Projects\Samples folder. 

Importing a partial netlist 
 

File menu > Import 

In this activity you assign power and ground to the ball pads. 
1. Navigate to the \PADS Projects\Samples folder and select the file 

PGnetlist.asc. 
2. Click Open to import the netlist.  
In this file, PWR and GND are assigned to their respective ball pads. 

Displaying and hiding connections 
 

View menu > Nets 

For a less cluttered display you can turn connections on or off. In this step you 
undisplay the power and ground connections but leave the pins highlighted. 
1. In the Net List area, select both the PWR and GND nets. 
2. Click Add to add PWR and GND to the view list. 
3. In the View List area, select both the PWR and GND nets. 
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4. In the View Unroutes Details area, select None. 
5. In the Color by Net area, select the dark gray color box to highlight the PWR 

and GND pins. 
6. Click OK to accept the changes and close the dialog box. The connections are 

removed from the display but the PWR and GND pins are highlighted. 

Creating connections interactively 
 

BGA button  > Add Connection button  

Some advanced IC package designs do not require a fixed netlist. In these cases 
the connectivity is left to the designer's discretion. The following exercises show 
you how to create connections interactively and swap pin assignments. 

Zoom area: 

 
1. Zoom into the upper left area of the wire bond fanout pattern as shown. 
2. Using the modeless Search command, type s u1.248 and then press Enter. 

Press Spacebar to start the connection. 
3. Right-click and click Derive Net Name from Pin Function. This assigns the 

net name automatically based on the pin function name. 
4. Using the modeless Search command type s bga1.g4 and Enter. Press 

Spacebar to select the pin. 
5. Press Esc to end the connection. 
6. Repeat these steps to generate the connections shown above. 
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Swapping pins 
 

Swap Pin button  

1. Type the modeless Search command s bga1.g4 and then press Enter.  
2. Press Spacebar to select the first pin to swap. The remaining pins will dim. 
3. Select the ball pad to the immediate left (BGA1.G3).. 
4. On the Confirm Pin Swap dialog box, select Don’t display again.  
5. Click OK to close the dialog box.  

Result: The connections have been swapped between the pins. 
6. Repeat these steps for several more swaps. If you make a mistake, right-click 

and click Undo Last Swap. 
7. Do not save a copy of the design. 

You completed the connecting with a netlist tutorial. 
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Connecting Without a Netlist 

There are several tools in PADS Layout for interconnecting substrate bond pads 
to BGA pads. In this tutorial, you'll use several tools to connect the die 
component to the BGA.  

In this lesson: 

 Using the manual route editor 
 Starting routing 
 Completing traces 
 Deriving net names 
 Guiding the pad entry 
 Smoothing the pad entry and exit 
 Modifying traces 
 Using the Dynamic Route Editor 
 Copying traces 
 Creating a fanout pattern 

Restriction 

 This tutorial requires the Dynamic Route Editing and General Editing 
security options. On the Help menu, click Installed Options to determine 
whether you can proceed. 

Preparation 

If it is not already running, start PADS Layout and open the file named 
PBGAtutorial_6.pcb in the \PADS Projects\Samples folder. 

Using the manual route editor 
 

The basic route editor is the core route editing function of PADS Layout. Many of 
the operations used to create traces in the route editor resemble other operations 
in PADS Layout, such as those used for creating polygons and line items. This 
minimizes your learning curve by letting you apply the same operations to many 
areas of PADS Layout. 
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Typically in PADS Layout, all connections are converted to traces by selecting 
the connection, digitizing new corners, and introducing layer changes using 
mouse and keyboard combinations. In PADS Layout you can also start 
interconnecting components without a netlist. In the following exercises, you'll 
use the route editor to create routes on the fly. 

Resizing the view 

1. Press Ctrl+B to view the entire design. 
2. Zoom into the upper-right part of the U1 component. 
3. Locate substrate bond pad 65 using the Search modeless command. Type s 

u1.65 and press Enter. The pointer moves to the location of U1.65. 

Setting a routing and via grid 

For easier trace and via positioning, set a routing grid of 0 and a via grid of .1. To 
set the grids, use modeless commands: 
1. Set the working grid to 0 by typing g0 and pressing Enter. The message All 

grids set to 0.00025 0.00025 appears in the status bar. 
2. Set the via grid to .1 by typing gv.1 and pressing Enter. The message Via grid 

set to 0.1 0.1 appears in the status bar. 

Starting routing 
 

BGA button  > Add Route button  

1. With nothing selected right-click and click Select Pins/Vias/Tacks to change 
the Selection Filter. 

2. On the standard toolbar, select Die Side as the current layer from the 
Layer list. 

3. Use the modeless command ao to set the angle mode to orthogonal. 
4. Select substrate bond pad U1.65 on the Die Side layer. The beginning of a 

new route segment dynamically attaches to the pointer. 
Tip: At this point in the tutorial, PADS Layout is in DRC Off mode. New 
trace segments are not prevented from shorting to other objects. 

5. Once you initiate the new trace, move the pointer around and note how one 
end of the connection attaches to the component pin and the other end of the 
connection attaches to the pointer. 

Tips:  
 New segments are constrained to 90-degree increments from the origin of 

the trace segment. This is because the current trace angle mode is 
Orthogonal. 
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 At any point in this exercise you can exit the routing command operation 
by pressing the Esc key. You can also click the Undo button on the 
standard toolbar to undo any actions. 

Changing the trace angle mode 

You can change the trace angle mode during routing by clicking commands on 
the shortcut menu. 

To change the trace angle mode: 

1. While the trace is attached to the pointer, right-click, point to Angle Mode, 
and click Diagonal.  

2. Move the pointer around. Notice how new segments are now constrained to 
45-degree increments. 

Adding and deleting corners 

You can add new corners to a trace segment by clicking the left mouse button. To 
remove new corners, press the Backspace key. Experiment with inserting and 
deleting new trace corners. 

Changing layers 

You can change layers while routing in the same way that you add corners, 
except Shift+click. You can change layers at the current pointer location or at the 
last corner location while routing.  

To initiate a layer change at the current pointer location: 

 With a new trace segment attached to the pointer, Shift+click. 
Result: A new via is added at the location of the click and the second layer of 
the routing layer pair is now the current layer. 

 Alternative: To initiate a layer change at the last corner location, press F4 or 
right-click and click Layer Toggle while a new trace segment is attached to 
the pointer. Vias are not added if the last trace corner is located inside a 
component pad. 

Selecting a destination for new traces 

Before you can complete a new trace added on the fly, you must select a 
destination. There are two methods to choose a destination for a new trace in 
PADS Layout: use the Select Target command or double-click the left mouse 
button. 

To choose a destination with the Select Target command: 

1. With a trace segment attached to the pointer, right-click and click Select 
Target. 
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2. Move the pointer over the destination target, and click. 
The pointer returns to the end of the trace segment. 

To choose a destination using a double-click: 

 With a trace segment attached to the pointer, move the pointer over the 
destination target and double-click. 

Completing traces 
 

You can complete a trace in two ways. Use the steps in the "Start Routing" 
section to route traces from the substrate bond pads. 
Tip: Remember, you are routing between a substrate bond pad and the ball grid 
pad, which are on different layers. You must add a via to complete the trace. 

To complete a trace using the Complete command: 

1. Start a new trace from one of the substrate bond pads. 
2. Select a destination by right-clicking and clicking Select Target. 
3. Shift+click to insert a via. 
4. While the trace segment is attached to the pointer, right-click and click 

Complete. 
Alternative: Double-click your left mouse button.  
Result: The trace completes from its start to its destination and the trace 
pattern is "smoothed" or cleaned up. 

To complete a trace without using the Complete command: 

1. Start a new trace from one of the substrate bond pads. 
2. Select a destination by right-clicking and clicking Select Target. 
3. Shift+click to insert a via. 
4. With the trace segment attached to the pointer, define a trace pattern and 

position your pointer over the center of the BGA pad. 
5. When the bull's-eye symbol appears, click. 

Result: The trace is completed, in many instances without "smoothing" or 
cleaning up the new trace. 

Practice creating new traces on the fly using both target selection and completion 
methods. 
Tip: At any point in this exercise you can exit the routing command operation by 
pressing the Esc key. You can also click the Undo button on the standard toolbar 
to undo any actions. 
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Deriving net names 
 

Window menu > Status 

PADS Layout names all new nets with a system default of $$$<a number>. 
When designing for advanced packaging, you may prefer for the name of the net 
connecting the die pad to the BGA pad to match the function or the signal name 
of the die pad. For example, the die pad for RESET connects to a BGA pad and 
the name of the net that connects them is RESET. 
PADS Layout can derive net names from pin function names when adding traces 
on the fly. You can enable and disable this option only on the shortcut menu that 
appears when the Add Route command is active. 

To enable this option: 

1. Start a new trace from a substrate bond pad. 
Note that the net name appears at the top of the Status Window. This net 
name is a system default of $$$<a number> unless the net name is being 
derived from the pin function. 

2. Immediately after starting the new trace, right-click and examine the Derive 
Net Name from Pin Function option. A check will appear to the left of the 
menu entry indicating that the option is enabled. If enabled, the net name 
appearing at the top of the Status Window matches the function name for the 
substrate bond pad. 

3. Close the Status Window. 
This option is considered a static option. It remains in its current state until you 
select the option again on the shortcut menu to change its state. 

Guiding the pad entry 
 

Tools menu > Options > Routing tab 

To achieve optimum pad entry and exit, you can guide pad entry and exit as you 
route. Use this option to manually digitize the path of the last segment entering 
or exiting a pad. With this option enabled, the trace angle temporarily switches 
to any angle when you start a trace. The trace angle remains in any angle mode 
until you place the first corner of the trace, then trace angle mode returns to the 
current setting.  

To enable Guide Pad Entry: 

1. In the Pad Entry area, select the Guide Pad Entry check box. 
2. Click OK. 
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Result: Routing behavior is different than before. The following exercises repeat 
some of the previous exercises using guide pad entry. Be sure to start on a pad 
that currently has no traces or connections. 

Starting routing 

1. With nothing selected, right-click and click Select Pins/Vias/Tacks. 
2. Set the current DRC mode to Prevent by typing the modeless command drp 

and pressing Enter. 
3. Set the angle mode to orthogonal by typing the modeless command ao and 

pressing Enter. 
4. Set the Die Side as the current layer by selecting it from the Layer list on the 

standard toolbar. 
5. If not currently selected, click the Add Route button on the BGA toolbar. 

 
6. Select the substrate bond pad for U1.65. As it did before, the beginning of a 

new trace segment attaches to the pointer. 

To demonstrate the new pad exit behavior: 

1. Move the pointer in a circular fashion around the pad and notice how the first 
segment of the trace is an any-angle segment. 

2. Move the pointer very close to the end of the pad and notice the octagonal 
DRC violation indicator. The indicator appears because placing a corner at 
the current pointer location would violate the same net SMD to Corner 
Clearance rule. Therefore, clicking to add a new corner is disabled until the 
pointer is positioned further away from the pad and the indicator disappears. 

3. Move the pointer to a position where the indicator disappears, and then click 
to place the first corner. 

4. Move the pointer in a circular fashion around the corner and notice how the 
segment of the trace is now an orthogonal segment. 

To demonstrate the new pad entry behavior: 

1. Continue to route the new trace, right-click and click Select Target (rather 
than double-clicking) to select the target destination. 

2. Add a few corners and then Shift+click to add a via. Move the pointer toward 
the center of the target pad.   
Result: The last segment immediately converts to an any angle segment 
when the bull's-eye symbol appears. 
Tip: You must be on the BGA side to see the bull's-eye symbol, which is why 
you add a via to change layers. 

3. Click in the center of the target pad to complete the trace. 

Connecting Without a Netlist 33 



Smoothing the pad entry and exit 
 

Tools menu > Options > Routing tab 

A second option for pad entry and exit determines whether or not the pad entry 
or exit is smoothed during routing. For this option, the pad entry or exit is 
defined as the first or last segment attached to the pad. When this option is 
disabled, the manually digitized pad entries and exits are locked and can't be 
adjusted during smoothing operations. By default, this option is disabled so that 
guided pad entries and exits are preserved. 

To enable smooth pad entry and exit: 

1. In the Pad Entry area select the Smooth Pad Entry/Exit check box. 
2. Click OK. 

Experimenting with pad entry options 

Perform the manual routing exercises above with the Smooth Pad Entry/Exit 
check box selected. This helps you become familiar with the operation of these 
options and how they affect route-editing behavior. When you are comfortable 
with the use and operation of the options, exit the current mode, clear both Pad 
Entry options on the Routing tab of the Preferences dialog box, and continue to 
the next topic. 

Modifying traces 
 

You modify a trace by selecting a trace segment or via, and then using the 
commands available on the shortcut menu. You have more freedom to edit traces 
in DRC Off mode, but you can edit traces in any DRC mode. 

Deleting traces and trace segments 

You can easily delete trace segments or pin pairs. 

To delete traces or trace segments: 

1. With nothing selected, right-click, and click Select Anything. 
2. Select a segment of a completed trace and press Delete. 
3. Click the Undo button on the standard toolbar to undo the deletion. 

 
4. Shift+click on a trace (trace segment) to select the whole pin pair. 
5. Press Delete to unroute the pin pair. If DRC is on at all (set to Prevent, 

Ignore, or Warn), the message Delete Pin Pairs or Unroute Traces? appears. 
Click Unroute. 
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Experimenting with trace-editing commands 

Experiment with the trace-editing commands by selecting various trace 
segments, vias, and corners. Use the shortcut menus or the keyboard shortcuts 
to initiate the move, stretch, split, add corner, add via, or other editing 
commands. See PADS Layout Help for more information about these commands. 

Using the Dynamic Route Editor 
 

BGA button  > Dynamic Route button  

The Dynamic Route Editor (DRE) is another powerful interactive routing 
feature. Instead of digitizing each trace corner, as with the basic trace editor, you 
simply start the trace and move the pointer in the direction in which you want 
the trace to flow. Trace corners are dynamically added as you move the pointer. 

To dynamically route: 

1. With nothing selected, right-click and click Select Pins/Vias/Tacks. The 
Selection Filter updates. 

2. Set the angle mode to Orthogonal by typing the modeless command ao and 
pressing Enter. 

3. Set the DRC mode to Prevent by typing the modeless command drp and 
pressing Enter. 

4. If necessary, zoom into the top of the design for easier routing. 
5. Locate substrate bond pad 65 by typing the modeless search command 

s u1.65 and pressing Enter. 
6. Select pin 65 and start a trace using Dynamic Route. A trace dynamically 

attaches to the pointer. 
7. Move the pointer up and to the left towards the substrate bond pads along 

the top of the die. Note how the trace stops at the edge of the pad even when 
you move the pointer over the adjacent bond pads. 

8. Move the pointer until it is slightly above or below the adjacent bond pads. 
Notice how a new trace pattern is created around the obstacle automatically. 

Experimenting with DRE 

Experiment with DRE by moving the pointer around obstacles with the trace 
attached. Once you are ready to select a destination, use the commands 
previously demonstrated in the manual routing exercises. 
Tip: To back up a trace with DRE, slowly trace back over the newly created  
trace pattern. 
1. Change the trace angle to Diagonal by typing ad and pressing Enter.  
2. Continue experimenting. Try the same exercises with the trace angle set to 

Any Angle by typing aa and pressing Enter. 
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Tip: At any point in this exercise, you can exit dynamic route editing by pressing 
Esc. You can also click the Undo button on the standard toolbar to undo any 
actions. 

Route connections with DRE 

Use DRE to complete traces. Many of the commands that apply to manual 
routing also apply to dynamic routing: 
 The Backspace key removes the last corner added. 
 Shift+click inserts a via at the current pointer location and causes a 

level change. 
 Ctrl+click ends the trace at the current location with or without a via. 

Dynamic reroute with DRE 

You can also use DRE to reroute traces the same way as the manual route editor. 

To reroute a trace with DRE: 

1. Right-click and click Select Traces/Pins. 
2. Select any trace segment on any trace, right-click and click Dynamic Route if 

not already in Dynamic Route mode. 
3. Create a new trace pattern and complete it by double-clicking on any other 

point in the trace or trace segment. Otherwise, use normal trace completion 
commands when completing component pins and vias during reroute. 
Tip: When you try to complete another point of the trace, the first click of 
the double-click attaches the new pattern to the existing pattern. The second 
click completes the reroute. It may take a few tries to adjust to completing 
traces this way. For best results, minimize mouse movements while  
double-clicking. 

Copying traces 
 

You can duplicate traces or trace segments to speed repetitive tasks by copying 
and placing previously created traces. In this section, you'll use the trace copy 
features to quickly create fanouts from the BGA pads. 

Preparation 

1. Open the file named PBGAtutorial_6b.pcb in the \PADS Projects\Samples 
folder.  

2. On the View menu click Board to view the entire design. 
3. Zoom into the upper right part of the design, centering the view on one of the 

BGA pads. 
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Setting a few preferences 

Ease the positioning of traces and vias by setting a routing grid and a few other 
preferences. 

To set the preferences: 

1. Type g0 and pressing Enter, to set the working grid to 0. 
Tip: Messages appear in the status bar as you complete these steps. 

2. Type gv.1 and press Enter, to set the via grid to 0.1. 
3. Type ad and press Enter, to set the angle mode to diagonal. 
4. Type e and press Enter, to set the end via mode.  

Result: The message End Via Mode Set appears in the status bar. If End No 
Via Mode Set appears instead, type e and press Enter until it appears. 

5. Type dro and press Enter, to turn Design Rules Checking off. 

Creating a fanout pattern 
 

BGA button  > Add Route button  

To begin copying traces, create a fanout pattern to serve as the template for 
the copies.  

To create the pattern: 

1. On the standard toolbar, select the BGA Side from the Layer list. 
2. Select the pin attached to the upper right-most ball pad with a connection.  

Result: A new trace starts and attaches to the pointer. 
3. Move the pointer to the position shown in the graphic below. Ctrl+click to end 

the trace with a via attached. 
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Via position: 

 

To copy traces: 

1. Revert to Select mode by clicking the Select button on the BGA toolbar. 
 

2. With nothing selected, right-click and click Select Traces/Pins/Unroutes. 
3. Position the pointer over the diagonal trace segment and click to select it. 
4. Position the pointer over the via and Ctrl+click to add it to the selected 

objects. 
5. On the Edit menu click Copy. A copy of the trace attaches to the pointer. 
6. Right-click, and then click Next Base Point. 
7. With a trace attached to the pointer, click over the pin below the current BGA 

pad to add a copy of the trace. A copy is added and the pointer jumps to the 
next pad automatically. 

8. Right-click and click Repeat.. 
9. On the Copy Route Repeat dialog box, type 10 and then click OK.  

Result: Ten copies of the trace and via are added. 
10. Right-click, and click Cancel. 

Tip: You cannot use Esc to exit copy routines. You must wait until the routine 
completes. If the routine produces unexpected results, you can click the Undo 
button to undo any actions. 

11. Do not save a copy of the design. 

You completed the connecting without a netlist tutorial. 
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Connecting With the Route Wizard  

The BGA Route Wizard is an automatic connection-generating and autorouting 
tool. It eliminates repetitive and often tedious design tasks. The BGA Route 
Wizard has two modes of operation: 
 Generate Connections   Automatically generates connections between 

substrate bond pads and BGA package pads. It calculates the shortest 
connection lengths with the fewest number of crossovers. 

 Generate Connections and Route   Generates a netlist using the same 
features as Generate Connections mode, and routes the design automatically 
using established design rules. 

In this lesson: 

 Starting the BGA Route Wizard 
 Setting routing options 
 Choosing pads to process 
 Setting BGA fanout options 
 Running the BGA Route Wizard 

Restriction 

 This tutorial requires the Radial Placement, Auto-connect, BGA Fanout, 
General Editing and Plating Tails licensing options. On the Help menu, click 
Installed Options to determine whether you can proceed. 

Preparation 

If it is not already running, start PADS Layout and open the file named 
PBGAtutorial_6.pcb in the \PADS Projects\Samples folder. 

Starting the BGA Route Wizard 
 

BGA button  > Route Wizard button  

 In the Action area of the BGA Route Wizard dialog box, select Generate 
Connections and Route. 
Result: The Routing, Select Pads, and BGA Fanouts tabs are enabled. 

Setting routing options 
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BGA Route Wizard > Routing tab 

Use the Routing tab to set trace width, plating tail, and other routing-related 
options. Options for net name preferences are also available in this tab.  

To set routing options: 

1. In the Include area, make sure Plating Tails is selected. 
2. In the Plating Tails area, in the Tail Length box, type 1 to replace the 

default value. 
3. In the Net Name Preferences area select Derive Net Name from Pin 

Function. 

Choosing pads to process 
 

BGA Route Wizard > Select Pads tab 

Use the Select Pads tab to specify which package pads and substrate bond pads 
to process when building connections and routing. You can click individual pads, 
pads connected to nets, or entire sides of the package. By default, processing 
includes all package and substrate bond pads. 

To exclude the center BGA pads: 

1. Click Select Graphically.  
Result: The BGA Route Wizard dialog box closes and the Select Graphically 
dialog box appears. 

2. Click Select Pins to Exclude. 
3. Drag the pointer from -10.7, -9.4 to -9.5, 9.6 to area-select the ball pads on the 

left side of the inside ring. 
Result: The ball pads highlight. See the white pads in the example below. 
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Pads to select: 

 
4. Repeat step 4 to select the remaining ball pads on the inside ring. Remember 

to press Ctrl before selecting because you are adding to the selection set. 
5. Click OK in the Select Graphically dialog box. The Select Graphically dialog 

box closes, the BGA Route Wizard dialog box appears, and the pins are added 
to the Excluded list in the BGA Pins area. 

To exclude pads assigned to the GND and PWR nets: 

1. In the Substrate Bond Pads area, on the Included list, click the Net column to 
sort the list by net.  
Result: The pads now appear first in the list. 

2. Ctrl+click all substrate bond pads connected to GND and PWR. 
3. In the Substrate Bond Pads area, click Exclude. This moves the pads 

attached to GND and PWR to the Excluded list in the Substrate Bond 
Pads area. 

4. Repeat these steps for the BGA Pins you want to exclude. 
5. Browse the Included list for both substrate bond pads and BGA pins to verify 

that no PWR or GND nets appear in the list. 
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Setting BGA fanout options 
 

BGA Route Wizard > BGA Fanouts tab 

You use the BGA Fanouts tab to control the style, direction, and trace width of 
BGA Fanouts. 

To set these options: 

 In the Fanout Style list, select Diagonal. 

Running the BGA Route Wizard 
 

BGA Route Wizard > Run button 

Create connections, traces and plating tails. 

To run the Generate Connections and Route function: 

Tip: You can interrupt processing at any time by pressing the Esc key. 
1. When processing completes, a report appears in your default text editor. 

Review the report then close it when you are done. 
2. Do not save a copy of the design. 

You completed the connecting with the route wizard tutorial. 
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Adding Teardrops 

PADS Layout includes features to generate teardrops automatically. In this 
lesson, you'll assign teardrop preferences and add teardrops to all trace end 
points on the design.  

In this lesson: 

 Enabling teardrop generation 
 Modifying teardrop geometry 

Restriction 

 This tutorial requires the Analog licensing option. On the Help menu, click 
Installed Options to determine whether you can proceed. 

Preparation 

If it is not already running, start PADS Layout and open the file named 
PBGAtutorial_7.pcb in the \PADS Projects\Samples folder.  

Enabling teardrop generation 
 

Tools menu > Options > Routing tab 

You enable teardrop generation in the Routing tab of the Preferences dialog box. 
Once you enable this option, a teardrop is added automatically to each trace end 
attached to a via or pad. Disabling the teardrop generation removes the 
teardrops previously generated.  

To enable teardrop generation: 

 Select Generate Teardrops, and then click OK.  
Result: Teardrops are immediately added to each route end at vias and pads. 

Modifying teardrop geometry 
 

Now that you've learned how to generate and remove teardrops, you can adjust 
the teardrop geometry. In this section, you'll learn how to change the geometry of 
one or all teardrops by changing the Query/Modify Teardrop settings. 
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Resize the view 

1. Press Ctrl+B to view the entire design. 
2. Zoom into an area of the design, centering the view on a BGA pad and its 

fanout to the via. 

Modify the teardrop parameters 

You can change teardrop parameters by selecting a trace segment with teardrops 
at one end of the segment and then open the Q/M Teardrop on Traces dialog box. 
Use this dialog box to make adjustments to the selected teardrops attached to 
the segment, apply changes to all teardrops, or apply them to teardrops on the 
current layer. 

To modify teardrops: 

1. With nothing selected, right-click, and then click Select Traces/Pins. 
2. Select the diagonal segment attached to a BGA pad, right-click, and then 

click Q/M Teardrop. The diagonal segment may be difficult to see. It runs 
through the center of the teardrop. 

3. On the Q/M Teardrop on Traces dialog box, click All in the Apply to area to 
apply the changes to all teardrops. 

4. In the Shape area, click the Line button. 
5. In the Length Ratio and Width Ratio boxes, type 100. 
6. In the Parameters area, select the Auto Adjust check box, until the 

checkmark appears in black instead of in gray. 
7. Click OK. 

Result: Once the process is completed, all teardrops update to resemble a 
tapered trace. 

8. Do not save a copy of the design. 

You completed the adding teardrops tutorial. 
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Creating Die Flags and Power Rings  

PADS Layout provides functionality that enables parametric construction of die 
flags and power rings.  

In this lesson: 

 Setting the copper hatch grid 
 Defining the die flag 
 Adding power rings 

Restriction 

 This tutorial has no restrictions.  

Preparation 

If it is not already running, start PADS Layout and open the file named 
PBGAtutorial_8.pcb in the \PADS Projects\Samples folder.  

Setting the copper hatch grid 
 

Tools menu > Options > Grids tab 

To set the copper hatch grid: 

1. In the Hatch Grid area, in the Copper and Keepout boxes, type 0. 
2. Click OK. 

Defining the die flag 
 

BGA button  > Die Flag Wizard button  

Zoom into an area of the design, centering the view on the die and the wire bond 
fanout pattern. 
1. With nothing selected, right-click and click Select Component. 
2. Select component U1. 
3. In the Die Flag and Rings area, ensure that Die Flag is selected. 
4. In the Layer list, select Die Side. 
5. In the Shape list, select Rounded Rectangle. 
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6. In the Spacing box, type .25. 
7. In the Width box, type .5. 
8. In the Net list, select GND. 
9. In the Spokes area, do the following: 

 In the Number list select 8. 
 In the Width box type .6. 
 In the Miter Size box type .1. 
 Select Project from corners. 

10. In the Center Paddle area, in the Coverage box, type 50. 
Result: The workspace will update to show the die flag parameters. 

Adding power rings 
 

1. In the Die Flag and Rings area, click Add.  
Result: A new ring named Ring1 is added. 

2. In the Die Flag and Rings area, select Ring1. 
3. In the Layer list, select Die Side. 
4. In the Shape list, select Rounded Rectangle. 
5. In the Spacing box, type .25. 
6. In the Width box, type .5. 
7. In the Net list, select PWR. 
8. Click Create to generate the design copper for the die flag and power ring. 

Tip: To remove the die flag and power rings once they have been created in 
design copper set the selection filter to Select Shapes, select a window 
encompassing the die flag and power rings, and press Delete. 

9. Do not save a copy of the design. 

You completed the creating die flags and power rings tutorial. 
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Connecting Power and Ground Pads  

In this lesson: 

 Highlighting the power net and pins 
 Setting options 
 Routing the power connections 
 Creating via fanouts for ground ball pads 

Restriction 

 This tutorial requires the General Editing licensing option. On the Help 
menu, click Installed Options to determine whether you can proceed. 

Preparation 

If it is not already running, start PADS Layout and open the file named 
PBGAtutorial_9.pcb in the \PADS Projects\Samples folder. 

Highlighting the power net and pins 
 

View menu > Nets 

1. In the View List area, select the PWR net. 
2. In the Color by Net area, select bright purple. 
3. Click OK. 

Setting options 
 

To ease the positioning of traces and vias, it is best to set a routing grid and a 
few other options. 
Tip: Messages appear in the status bar as you complete these steps. 

To set the options: 

1. Type g0 and press Enter to set the working grid to 0.  
2. Type gv.05 and press Enter to set the via grid to .05. 
3. Type ad and press Enter to set the angle mode to diagonal. 
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4. Type e and press Enter to set the end via mode. The message End Via Mode 
Set appears in the status bar. If another message appears, continue to type e 
and press Enter until the message End Via Mode Set appears. 

Routing the power connections 
 

Setup menu > Display Colors 

1. Zoom into the lower left quadrant of the design. 
2. Set the Die Side traces to Black to simplify the design. 
3. Click OK to close the dialog box. 
4. On the BGA toolbar, click the Add Route button. 

 
5. Using the modeless Search command, type s bga1.v4 and press Enter. Press 

Spacebar to start routing. 
6. Right-click and click Width. 
7. Type .4 in the Modeless Command dialog box and press Enter. 

Power connections: 

 
8. Route the connection over to the power ring as shown. 
9. Use Ctrl+click to end with a via going up to the power ring. 
10. Repeat the routing step to connect all the PWR ball pads to the power ring. 

Because the design is symmetrical, you can use the copy command once you 
have made a few connections. 

Tip: Remember to change the traces on Die Side back to red so you can see them. 
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Creating via fanouts for ground ball pads 
 

Setup menu > Display Colors 

1. Below the Design Items area, clear the Copper check box and click OK. 
2. Zoom into the center ball pad array. 
3. On the BGA toolbar, click the Add Route button.  
4. Type the modeless Search command s bga1.p10 and press Spacebar to start 

routing. 
5. Right-click and click Width. 
6. Type .4 into the Modeless Command dialog box and press Enter. 

GND connections: 

 
7. Route the connection as shown above. 
8. Ctrl+click to end with a via. 
9. Repeat the routing step to fan out the GND as shown. Remember you can 

copy the objects, but ensure you set the selection filter to Traces/Pins first. 
10. On the Setup menu click Display Colors. 
11. Below the Design Items area, select the Copper check box and click OK. 
12. Do not save a copy of the design. 

You completed the connecting power and ground pads tutorial. 
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Creating Copper Areas 

In this lesson: 

 Updating design rules and preferences 
 Adding the GND copper area 

Restriction 

 This tutorial requires the Copper Flood and Drafting Editing licensing 
options. On the Help menu, click Installed Options to determine whether you 
can proceed. 

Preparation 

If it is not already running, start PADS Layout and open the file named 
PBGAtutorial_10.pcb in the \PADS Projects\Samples folder.  

Updating design rules and preferences 
 

Setup menu > Design Rules > Rules dialog box > Default button > Default rules dialog box > 
Clearance button 

Before generating copper areas you must increase the rules. 

To set the rules: 

1. In the Clearance Rules dialog box, in the Clearance area, set the rules 
Copper-Trace, Copper-Via, Copper-Pad and Copper-SMD to .2. 

2. Click OK, and close the Default Rules and Rules dialog boxes. 
3. On the Setup menu, click Preferences. 
4. Click the Thermals tab. 
5. In the Non-drilled Thermals area, select Flood Over to allow flooding 

over vias. 
6. Click the Drafting tab. 
7. In the Flood area, in the Min Hatch Area box, type .6. 
8. Click OK. 
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Adding the GND copper area 
 

To add the copper area: 

1. Drafting button  > Copper Pour button . 
2. On the View menu, click Extents to view the entire design. 
3. Verify the active layer is set to BGA Side. 
4. Right-click and click Rectangle. 
5. Type the modeless Search command s bga1.ac1 and press Enter. Press 

Spacebar. 
6. Type the modeless Search command s bga1.a23 and press Enter. Press 

Spacebar. 

Modifying the copper pour shape 

To modify the copper area: 

1. Select button . 
2. With nothing selected, right-click and click Select Shapes. 
3. Select the Copper Pour Shape created in the previous step. 
4. Right-click and click Query/Modify. 
5. In the Q/M Drafting dialog box, in the Width box, type .15. 

Assigning a net to the copper 

To assign the net: 

1. In the Net area, select GND. 
2. Click Apply. 
3. Click the Preferences button. 
4. Select the Flood Over Vias check box and click OK. 
5. Click Yes in the Proceed with Flood message box. 
6. Close the Q/M Drafting dialog box. 
7. Do not save a copy of the design. 

You completed the creating copper areas tutorial. 
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Creating a Wire Bond Diagram 

A typical requirement for documenting an advanced packaging design is to 
create a wire bond diagram. A wire bond diagram presents a picture of the die 
pads, wire bonds, and substrate bond pads. In addition, for each wire bond the 
name of the BGA pad to which it's connected appears adjacent to the substrate 
bond pad. In this tutorial, you will use the wire bond diagram command to add 
the BGA pad name labels to the design. 

In this lesson: 

 Adjusting color settings 
 Creating the wire bond diagram 

Restriction 

 This tutorial requires the Drafting Editing and General Editing licensing 
options. On the Help menu, click Installed Options to determine whether you 
can proceed: 

Preparation 

If it is not already running, start PADS Layout and open the file named 
PBGAtutorial_11.pcb in the \PADS Projects\Samples folder.  

Adjusting color settings 
 

Setup menu > Display Colors 

To demonstrate wire bond diagram, clear the display of those items not relevant 
to the wire bond diagram. 

To adjust color settings: 

1. Clear the Traces, Vias, Copper, and Errors check boxes under those self-titled 
columns. Notice how the entire column of color tiles disappears. 

2. Clear BGA Side next to that self-titled row. Notice how the entire row of color 
tiles disappears. 

3. Select the black (same as the background color) color box in the Selected 
Color area, and then click Connection in the Other area. 

4. Click OK to apply the color changes and close the Display Colors dialog box. 
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Creating the wire bond diagram 
 

BGA button  > Wire Bond Diagram button  

You use the wire bond diagram mode to define the parameters for the generation 
of the BGA pad name labels. You can apply this mode to a single pad or to all 
pads on a component. 

To start the command: 

1. Press Ctrl+B to view the entire design. 
2. Zoom into the top row of substrate bond pads. 
3. With nothing selected, right-click and click Select Components. 
4. Select one of the substrate bond pads.  

Result: The Add BGA Pin Labels dialog box appears. 

Setting the wire bond diagram preferences 

The preferences in the Add BGA Pin Labels dialog box let you specify which pad 
label to add for those die pads connected to more than one BGA pad. You can also 
set size and layer assignment preferences for the text label to add. 

To assign the preferences and add the labels: 

1. In the Width box type .01 to assign a text width. 
2. In the Height box type .12 to assign a text height. 
3. Click OK. 

Result: A label appears on each substrate bond pad. 

Rotating and moving the text labels 

Select button  

After you add the labels, you must rotate and move them as shown in the 
following graphic. 

Label position: 

  
1. With nothing selected, right-click and click Select Documentation. 
2. Type g0 and press Enter to set the working grid to 0. 
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3. Type dro and press Enter to turn off Design Rules Checking. 
4. Area-select all the BGA labels on the top of the die. 
5. Right-click, and then click Rotate 90.  

Result: All of the text labels are rotated 90 degrees counterclockwise. 
6. With the text labels still selected, right-click, and then click Move. All of the 

labels now move as a group and are attached dynamically to the pointer. 
7. Move the pointer and position the labels so they are adjacent to their 

respective substrate bond pads and click to place them. 
8. Repeat these steps until you position all of the labels. 
9. Do not save a copy of the design. 

You completed the creating a wire bond diagram tutorial. 
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Creating Wire Bond Reports 

A supplied Basic script enables you to create two different report files in 
Microsoft Excel: 
 A BGA pin (solder ball) to die function name report  
 A die function name to BGA pin report  

The output is sorted based on the report type you select. The reports perform 
connectivity reporting, verification, and die function name to net mapping. 

In this lesson: 

 Creating a wire bond report 
Tip: The report appears in a text file automatically if you do not have Excel on 
your system. 

Restriction 

 There are no restrictions for this tutorial.  

Preparation 

If it is not already running, start PADS Layout and open the file named 
PBGAtutorial_12.pcb in the\PADS Projects\Samples folder. 

Creating a wire bond report 
 

Tools menu > Basic Scripts > Basic Scripts 

To create a report file: 

1. In the Basic Scripts dialog box, select BGA Wirebond Report and 
click Run.  
Result: An Automation Utilities dialog box appears. 

2. Select BGA Pin to Die Function Name Report. 
3. Select Include Die Pin Numbers. 
4. Click OK to start the report. The message Depending on the complexity of 

your BGA design, this may take a moment or two appears.  
5. Click OK to continue. The connection report is generated and appears in 

Excel, as in the following graphic. 
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The die function report: 

 
6. After reviewing the report, you can save it by clicking Save As on the File 

menu. Select a name and location for the file. 
7. On the File menu, click Exit to return to PADS Layout. 
8. Click Close to close the Basic Scripts dialog box. 
9. Do not save a copy of the design. 

You completed the creating wire bond reports tutorial. 
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